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Welcome to LapLink 2000

With LapLink 2000’s award-winning remote control, file transfer, and chat features, you can
access e-mail, files, and office network resources when you’re on the road, work with computer
users at other locations, schedule file transfers, print documents to a remote printer, and more.
LapLink offers you a variety of reliable, easy-to-use options for connecting; simply choose the
option that is appropriate for the resources available on your computer and the computer you
want to connect to. To learn more about LapLink, see the online user’s guide and Help.

Whether you’re on the road, at home, or in the office, LapLink 2000 lets
you work faster, easier, and smarter than ever by providing you with safe
and reliable remote access.

O For moreinforma-  Using LapLink 2000 to connect to another LapLink computer is easy.

tion about connect- Depending on the resources available on your computer and the com-
ing to atnother puter you want to connect to, you can connect using:
?3"}'3“ €l S6€ pages 0 a modem U the Internet
U a serial, parallel,* or Universal Serial Bus U a local (IPX) network,
(USB)* LapLink cable such as Novell
U a wireless* connection, including the U a TCP/IP network
new Fast Infrared (FIR) connection O a CAPI/ISDN 2.0 device

* These connection methods are not supported in Windows NT or Windows 2000.

Once you're connected, you're ready to use LapLink’s powerful features.

U Remote Control lets you use your computer to perform tasks on
another computer.

U File Transfer lets you move and copy files between computers, specify
how files should be moved and copied, and synchronize the files in
folders on two computers automatically.

U Print Redirection lets you print a remote document at your site or use
a remote printer to print a local document.

U Text Chat and Voice Chat let you communicate with other users by
exchanging text messages or talking over a connection between two
sound-enabled computers.

0 To download Learning more about LapLink 2000: online user’s guide and Help

;Z%L;:;(n? ?ﬁ:nvveenk;u?- You can learn about LapLink 2000 through the online user’s guide and

go to http://www. Help. The online user’s guide is available in Adobe Acrobat format on the
laplink.com/prod- LapLink 2000 CD-ROM (or from your Web download directory if you've
ucts/ll2k/docs.asp downloaded LapLink 2000 from the Web).
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To install Adobe Acrobat and view the online user’s guide:

1 Start the LapLink Welcome screen by inserting the LapLink 2000 CD-
ROM in your CD-ROM drive.

2 Click View Documentation, and then click Get Adobe Acrobat Reader.

3 Once Acrobat Reader is installed, click View Documentation on the
LapLink Welcome screen, and then click the button for the user’s
guide you want to view.

The guide immediately opens in Acrobat Reader.
LapLink 2000 also features an online Help system to assist you as you use
LapLink. Help is available through the LapLink Help menu; it includes:

Searchable Help documentation Browse Help, and use the Help Index
and Find features to search for specific information. On the LapLink Help
menu, click Help Topics.

Troubleshooters Specify the problem you are having, and troubleshoot-
ers walk you through a series of possible solutions. In Help, double-click
the Troubleshooting book.

Quick Steps Quick Steps appear when you open a dialog box in LapLink
and give you information to help you complete the dialog box.

What's This Help Use the What's This Help to get information about dia-
log box items. Click the question mark in the upper right hand corner of
the dialog box, and then click the item you want help with.

F1 Help To get immediate help for an item on a menu, highlight the
menu item and press the F1 key.

Getting more information about LapLink
Technical support for LapLink is available by phone or on the Web.
U World Wide Web
Visit www.laplink.com/techsupport/
U US/Canada
Phone (425) 487-8803, Fax (425) 487-5440
U United Kingdom
Phone +44 (0) 1344 867 300, Fax +44 (0)1344 38 32 30
U Worldwide

Visit www.laplink.com/world/ for a list of international support num-
bers.

[J To download
Adobe Acrobat
Reader from the
Web, go to http://
www.adobe.com



| LapLink 2000 Quick Start Guide

What'’s new in LapLink 2000

LapLink 2000 gives you a wider range of remote access options while making remote access eas-
ier and more secure. Because passwords in LapLink 2000 are case-sensitive, those who have
upgraded from an older version of LapLink, or who connect to computers that are running an
older version of LapLink, may need to update their Address Book and Log-in List entries.

[J For more informa-
tion about new fea-
tures in LapLink
2000, see the online
user’s guide and
Help.

This version of LapLink includes a variety of new features for easier, more
secure, and more flexible remote access.

Internet access

Easier connections over the Internet LapLink 2000 eliminates the prob-
lem of having to know your IP address by letting you define your own
Internet address (like an e-mail address or a nickname). This makes it eas-
ier for other users to connect to your computer.

Improved security

Folder-level security You can now closely control file access by specifying
the drives and folders that a specific user, or all users, can view and access
on your computer.

Improved data encryption With LapLink 2000's enhanced encryption
capabilities, transferring data is now even more secure. Advanced users
can opt to use another installed cryptographic method if they choose.

Protection from unauthorized access LapLink 2000 lets you lock out
users who enter a certain number of wrong passwords, thus protecting
you against unauthorized access to your computer.

A new way to connect

LinkToNet An alternative to Dial-Up Networking, LinkToNet lets you
access your network without dialing directly in to the network server.

With LinkToNet, you can set up your office computer as a LinkToNet
host. You can then dial in to your office computer and access your office
network and Internet connection.

Use a LinkToNet connection to connect to other LapLink computers on
your network or on the Internet. You can also use it to browse the Inter-
net through your office’s Internet connection and to access other net-
work resources.
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Connecting with computers that are running older versions of LapLink

To connect to a computer that is running an
older version of LapLink, type the password in
all UPPERCASE in the Password dialog box, or
retype the password in all UPPERCASE in the
Address Book entry for the computer.

Older
LAPLINK

To accept an incoming connection from a
computer running an older version of
LapLink, retype the password in all UPPERCASE
in the Log-in List entry for the computer.

Older
LAPLINK

Using passwords in LapLink 2000

Passwords in LapLink 2000 are case-sensitive. This means that LapLink
distinguishes between uppercase and lowercase letters, such as “A” and
“a.” When you create a new password, you can type it in all UPPERCASE,
all lowercase, or MiXeD CaSe.

Passwords in previous versions of LapLink are not case-sensitive. Thus, if O Passwords must
you are upgrading to LapLink 2000 from an older version of LapLink be 4-10 characters
(such as LapLink Tech, LapLink Pro, or LapLink 7.5 or older), or if you long. They can

plan to connect to computers that are running an older version, take the 'k:‘ecrl:‘i;fgslr:'a”n“ dm-
following steps to ensure that password-protected connections and fea- spa o es; spac e;, how-
tures can be accessed. ever, cannot be at the

beginning or end of

0 _in Li -
In your Address Book and Log-in List, retype the passwords for com the password.

puters that are running an older version of LapLink in all UPPERCASE.

Passwords in older versions of LapLink are not case-sensitive; they are [ For more informa-
always transmitted in uppercase format regardless of whether they tion about updating
were typed in uppercase when they were created. Therefore, in order your Address Book
for an older version of LapLink to recognize a password, or for LapLink ~ "d Logrin List, see

. . . the online user’s
2000 to recognize a password transmitted by an older version, the guide and Help
password must be typed in uppercase.

U If prompted to enter a password when connecting to a computer that
is running an older version of LapLink, type the password in all
UPPERCASE.

U When prompted to enter a local security password, type that pass-
word exactly as you typed it on the Local Security tab in the Security
dialog box, using uppercase and lowercase as appropriate.
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Installing LapLink 2000

Before you install LapLink 2000, make sure you have what you need to use the program on the
computers you want to connect. Once you've verified your setup, you're ready to install LapLink.
LapLink must be installed on both computers you want to connect.

Ul LapLink for Win-
dows 3.1 is included
with LapLink 2000.

Ll Dial-up server
programs include the
Dial-Up Networking
server included with
the Microsoft PLUS!
Pack for Windows 95,
the Dial-Up Network-
ing server included in
Windows 98, and
Windows NT Remote
Access Server.

[ Dedicated dial-up
servers include Nov-
ell NetWare Connect
and Shiva NetMo-
dem.

General requirements for each computer

U Microsoft Windows 95, 98, 2000, or NT 4.0

U Intel or Intel-compatible 486/100 processor (or better)

U 16 MB of memory (24 MB recommended)

0 15 MB of available hard disk space (for a complete installation)
U VGA monitor (or better)

U Microsoft mouse or compatible pointing device

Requirements for modem communication

0 Windows 95/98: Windows- or Hayes-compatible modem

0 Windows NT/2000: Modem set up in Windows NT/2000 (with TAPI)
Requirements for network communication

U For IPX connections: Microsoft IPX-compatible protocol configured
for a network adapter

U For TCP/IP connections: Microsoft TCP/IP-compatible protocol con-
figured for a network adapter

Requirements for Dial-Up Networking communication

U Guest computer: Dial-Up Networking feature of Windows installed,
with a Dial-Up Networking connection to the dial-up server

U Host computer: Running a dial-up server program, or accessible via a
dedicated dial-up server that supports incoming Dial-Up Networking
connections

Requirements for LinkToNet communication
U Guest computer: Dial-Up Networking configured with TCP/IP

U Host computer: An Ethernet or Token Ring network connection
using a Microsoft TCP/IP stack and a modem or other TAPI device

Requirements for cable communication

U For serial connections (including USB): For serial, a LapLink serial
cable and an RS-232 serial (COM) port on each computer. For USB, a
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LapLink Universal Serial Bus (USB) cable and a USB port on each com-
puter. (USB cable connections are available in Windows 95/98 only.)

U For parallel connections (Windows 95/98 only): A LapLink parallel
cable and a parallel (printer) port on each computer, or a Direct-
Parallel Universal cable and an Extended Capabilities Port (ECP) on
each computer

Requirements for wireless communication (Windows 95/98 only)
U Infrared devices or AirShare Radio Modules. Infrared options include:

U Ports and devices supported by the Windows Infrared communica-
tions driver (IrDA) 1.0 or 2.0 (driver installed on both computers)

U Devices such as the Extended Systems JetEye Infrared PC Interface
(baud-switchable only), configured to work in LapLink

U Built-in infrared devices, including Fast Infrared (FIR)

Requirements for CAPI 2.0/ISDN communication

U An ISDN line and ISDN adapter with a CAPI 2.0-compliant driver on
both ends of the connection

Requirements for Voice Chat (must be installed on each computer)

U A sound card or sound device, speakers or headphones, and a micro-
phone (A full duplex sound card driver is recommended.)

Installing LapLink 2000
To install LapLink 2000:

1 Insert the LapLink CD-ROM in a CD-ROM drive, or, if you down-
loaded LapLink from the Web, double-click the Welcome.exe file in
the folder where you downloaded LapLink.

2 Click Install LapLink 2000, and follow the instructions on the screen.

Installing LapLink for Windows 3.1

You can also install LapLink for Windows 3.1 to connect Windows 3.1
computers to each other and to other computers running LapLink.

To install LapLink for Windows 3.1 from the LapLink CD-ROM:

1 Insert the LapLink CD-ROM in the Windows 3.1 computer.

2 In the Windows Program Manager, click Run on the File menu.

3 Type e:\startup.exe (where e is assigned to the CD-ROM drive); click OK.

4 Specify your computer name and connection type used (if modem,
cable, or wireless, specify the port where the device is located).

U To purchase
cables, contact
LapLink.com or a
LapLink reseller.

U In LapLink, wire-
less connections are
short-range, usually
between two infra-
red devices. If you are
using a cellular
modem, connect
using Connect over
Modem. If you are
using a wireless LAN
adapter, connect
using Connect over
Network.

U If the LapLink
Welcome screen does
not appear, open
Windows Explorer
and double-click
Startup.exe on the
LapLink CD-ROM.

Ll To create floppy
disks for LapLink for
Windows 3.1, locate
the Win16 folder on
your CD-ROM. In the
LLW16 subfolder,
copy the files in
\DISK1 and \DISK2
to two floppy disks.

9
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Getting started: setting security and allowing others to connect

After you install LapLink 2000, you can make outgoing connections to other computers, but
other computers cannot open incoming connections to yours except by cable or wireless. To
allow incoming connections, change the security setup by creating one or more entries in the
Log-in List, or by allowing public access. You can restrict user access as necessary, specifying who

can connect to your computer and what they can see and do once connected.

U To set up security
for cable and wireless
connections, click the
Enforce Security
option on the Local
Security tab. For
more information,
see the online user’s
guide and Help.

O For more informa-
tion about selecting
options on the Folder
Security, Modem
Callback, and LinkTo-
Net tabs, see the
online user’s guide
and Help.

10

The safest way to allow incoming connections is to set up password-pro-
tected access through the Log-in List. However, you can also set up your
computer as a public system, open to anyone who can connect.

Once you've configured your security setup, users can access your com-
puter using a modem, network, CAPI 2.0/ISDN device, or the Internet.
You won't need to modify this setup unless your security needs change.

Allowing others to connect to your computer

To specify who can connect to your computer:

1 Click the Security button on the LinkBar.

2 On the General tab, click Log-in List Only (Protected System).
3 Click the Log-in List button, and then click the Add button.
4

On the General tab, type the log-in name and password the user must
provide to connect to your computer.

5 Under Services, check the services that you want to make available to
the user, such as Remote Control and File Transfer.

6 If you've checked Remote Control as an available service, check the
appropriate options under Locking Permissions to indicate whether
the user can blank your computer screen and disable its mouse and
keyboard.

7 Specify any additional user access restrictions and preferences on the
Folder Security, Modem Callback, and LinkToNet tabs.

8 Click OK to add this person to your Log-in List.

A LapLink user can now connect to your computer by typing the log-
in name and password you specified.

You can also open your computer to connections from any LapLink user
if you choose. Though public users do not need to enter a password to
access your computer, you can limit what they can see and do.

To allow public access to your computer:

1 Click the Security button on the LinkBar.
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Setting up security in LapLink

. To set up security, click the Security button
= = o= . ( 3 )l )
L e T ‘| ﬁ'gl | on the LinkBar.

Security

Genersl | Local Secuity | Encryption | Lockout|

51 & Control access to your computer, For password pratection.
D chaose Log-n List Only, ther add an entry bo the Log-n List

—~Allow ¢
 Nobody (Fiivate System)
Nobody il be able to connect to your compuler.

Click Log-In List Only (Protected System) to
allow only people with names and passwords
you've specified to log in to your computer.

 Login [t Only Protected 3yt
You can specify a list of users wha can connect ka your computer;
they wil need to log in by typing & usemame and password. Click
the button below to add users and user privileges.

€ Argbady [Public System)

s
Login List j’

Then, click the Log-in List button to enter log-
in information and user restrictions.

Anybody can connet ta your computer, without needing to ype a
usermame o password. Click the button below to specify which
services and securiy options are allowed

Defaults

—1
FEutlie F‘nwleges:

Or click Anybody (Public System) to allow

| __— access to your computer without password

I protection, and then click the Public Privileges
button to specify what users can see and do.

0K | Cencel | gppb | Hen

Adding

Log-in List Privileges [7]x]

Genetal | Folder Securty | Modem Callback | LinkToMet | J—

@ Specify the alloed use privileges

[ User

Login Name: loise

someone to the Log-in List

To specify additional restrictions and connection
preferences for this user, click the appropriate tab.

Type a log-in name and password for the

Password

¥ File Transter ¥ Remote Contrsl W Print Redirection
¥ TestChat I~ Hoice Chat ~

-

Locking
{ 7 Blak Screen [ DissbleMowse [ Disable Keyboard %.

Defaults

remote user. The remote user will have to type
this when connecting.

T Specify the services the remote user can use.

If you allow Remote Control, specify whether
you allow blanking of your computer screen
and locking of your keyboard and mouse.

oK | Cancel sop | Hep |

Click the Public Privileges button.

2 On the General tab, click Anyone (Public System).

On the General tab, check the services and locking privileges you want

to grant to public users.

To limit public access to particular drives and folders, click the Folder

Security tab.
Click OK.

11
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Deciding how to connect to another computer

LapLink 2000 gives you a variety of options for connecting to another computer. To choose the
appropriate option, determine what resources are available on the local and remote computers.

Before you can use LapLink 2000 to connect to another computer, you
must determine how to make that connection using the resources avail-
able to the two computers.

O For instructions For example, if both computers have Internet access, you can connect
onhowto connectto  over the Internet. If one computer has a modem and the other has a
another computer, modem and network access, you can connect over a modem line, or you

see pages 14 and 15.

computer on the network.

Connecting over the Internet

can use LinkToNet to dial in to the modem and connect to any LapLink

Can you connect to
the Internet on the
local computer?

Then connect to another LapLink
computer over the Internet this way:

Yes

Connect to the Internet as usual, and then
use Connect over Internet in LapLink.

the Internet.

No, but the office has
a direct connection to

O Set up an office computer as a LinkToNet
host. Use Connect Over LinkToNet to dial
in to the modem on that computer and
connect to any LapLink computer over the
office Internet connection.

0 Oruse Connect Over Dial-Up Network-
ing to dial in to a network server and con-
nect over the office Internet connection.

Connecting over modems, networks, cables, and wireless devices

With this And this
available on | available on Connect to another LapLink
the local the remote computer this way:
computer computer
modem modem Use Connect over Modem and dial in
to the modem on the remote com-
puter.

12
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Deciding how to connect in LapLink 2000

LapLink gives you a variety of
options for connecting to
another computer.

Which method you choose
depends on the resources
available to both your com-
puter and the computer you
want to connect to.

modem
network
the Internet
cable
wireless
Dial-Up Networking
LinkToNet

With this And this
available on | available on Connect to another LapLink
the local the remote computer this way:
computer computer
modem modem and O Set up the remote computer as a
network LinkToNet host. Use Connect Over-
LinkToNet to dial in to that com-
puter’s modem and connect to any
LapLink computer on the network.
0 Oruse Connect over Modem to
connect directly to the remote com-
puter and access all of the network
resources available to that computer.
modem network with | Use Connect Over Dial-Up Network-
a dial-up ing to dial in to the dial-up server and
server connect to any LapLink computer on
the network.
network network Use Connect over Network.
parallel, parallel, Attach a LapLink parallel, serial, or USB

serial, or USB
port

serial, or USB
port

cable to each computer. The connec-
tion opens automatically. (Parallel and
USB connections are available in Win-
dows 95/98 only.)

wireless
device

wireless
device

The connection opens automatically as
soon as the devices come within range
of each other. (Wireless connections are
available in Windows 95/98 only.)

13
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Connecting to another computer

To use LapLink 2000, you must first connect to another computer that is also running LapLink.
Click the Connect button on the LapLink LinkBar and then specify how you want to connect.
Then, provide the connection information.

Ll To determine the
best way to connect
to another com-
puter, see pages 12
and 13.

[J Not all connec-
tions are supported in
all versions of Win-
dows; see pages 8
and 9 for details.

U Dial-Up Network-
ing and LinkToNet
both give dial-up
access to a network
from outside the
office. With Dial-Up
Networking, you dial
in to a network server
instead of a LinkTo-
Net host.

14

Before you can connect to another computer, both computers must be
running LapLink, and the connection method you want to use (such as
modem or network) must be active and available. You may also need to
know a log-in name and password in order to connect.

Making a connection

How your computer connects to another computer depends on the
resources available to the two computers. Determine what types of con-
nections each computer is able to make, and then select the appropriate
connection option.

To connect to another computer:

1 Click the Connect button on the LinkBar, and then click the connec-
tion method you want to use.

2 Under Services, check the services you want to open when you con-
nect. (You must check at least one service.)

3 Specify how to connect as described below:

Modem Use this method for modem-to-modem connections. Click
Manual Dial and type the dialing information for the remote com-
puter, or click an existing connection name. Click Dial.

Dial-Up Networking Use this method to connect to a network with a
dial-up server using a modem.

Click the Dial-Up Networking connection you want to use and choose
the appropriate dial-up networking options. Click Dial to dial your
modem. Once you've connected, LapLink asks you to specify which
LapLink computer on the network you want to connect to.

Network Use this method to connect to a computer on the same net-
work. Choose a computer on the network by clicking the computer
name.

You can also connect to a computer by typing its TCP/IP address, if it
has one; click the TCP/IP Addresses tab, click Manual Connect, and
type the TCP/IP address. Click OK.

Cable Use this method for computers connected by a cable. The com-
puter connected to your computer by cable is listed in the Connection
list. Click the computer name and click OK.



Connecting to another computer

Connecting in LapLink 2000

(=[]

75 7 Connect aver = First, click the Connect Over button.
Wizt Then, click the connection method you want to use.
@l Diahlp Networking (These can vary depending on your computer setup.)
Q_’I‘ RIS
Connect over Modem HE
m Cahle I:Endnect ta another computer using your
J])) Wireless [ =2nnecton T
Madeling Cancel
‘3\ Irternet fddress Book...
2 —- Fort Setup..
LinkTaoMNet to Eneste Dl opan o f ot s o Help
- Dialing
Phgne Nurnber [555-867-5303
Dialing Lacation |5 oo Location 2 | Ui

Connect Using: IFracl\caI Peripherals PC2ZEEMT 11,34 [COM1) j

~ Setvi
¥ File Transter
I Text Chat

I™ Bemote Contrel [ Print Redirection
I Yaice Chat

connection.

The Connect dialog box looks
different depending on the
method you use to connect.

If necessary, change any of
the connection information.

Check the services you want
to open when you make the

Wireless Use this method to connect computers that have short-range
wireless devices and are in range of each other. If a computer with a
wireless device is in range of your computer, it is listed in the Connec-
tion list. Click the computer name and click OK.

Internet Use this method if both computers have Internet access.
Click Manual Dial and type the remote computer’s Internet address
(which must be published on the host’s Internet directory server), or
click an existing connection name. Click OK.

LinkToNet Use this method to connect to an office network and Inter-
net connection with a modem. Click the type of LinkToNet connec-
tion that you want to make and follow the instructions on the screen
to set up a first-time LinkToNet connection.

Note that the network computer must be enabled as a LinkToNet host
to receive incoming connections, and the LapLink security setup of
the LinkToNet host must be changed to allow LinkToNet connections.

If prompted, type your log-in name and password. The connection is
made, and the services you selected are opened if the remote com-
puter is set up to allow you to access those services.

U If you can’t con-
nect, make sure that
the other computer is
set up to let you con-
nect, and that it
allows the services
that you requested.
For troubleshooting
information, see the
online user’s guide
and Help.

15
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Connecting to another computer

Connecting by cable

To connect two computers by LapLink cable, attach the cable (serial, parallel, or USB) to both
computers and start LapLink on both computers.

I Parallel and USB
cable connections are
not available in Win-
dows NT or Windows
2000.

16

Choose the type of cable—serial, parallel, or USB (Universal Serial Bus)—
based on the cables and ports you have available and the operating sys-
tems running on both machines.

Ports are the connectors to which you attach cables and peripherals (like
printers and external modems). To find out which types of ports are
available on the computers you want to connect, consult the documen-
tation or Windows Device Manager for each computer.

Once you decide which kind of cable connection you’ll use, plug a
LapLink cable into both computers. Attach a LapLink serial cable to a
serial port on each computer, a LapLink parallel cable to a parallel port on
each computer, or a LapLink USB cable to a USB port or USB “hub”
device on each computer.

Before you connect by cable
0 Attach an end of the LapLink cable to each computer.

U Ensure that the proper port (serial, parallel, or USB) is enabled in
LapLink on both computers.

To enable a port on a computer, click the Options menu, and then
click Port Setup. Under Port Settings, highlight the port you want to
enable, and then check the Enable Port box.

U Run LapLink on both computers.

Cables to use for LapLink connections

For a serial, parallel, or USB cable connection, use a LapLink cable.
LapLink cables are available from LapLink.com.

If there is more than one type of cable port available to you, remember
that USB and parallel cable connections are the fastest. USB cables can
transfer data up to seven times faster than serial cables.

In addition, you can attach a USB cable to any USB peripheral that incor-
porates a “hub” to which other devices can be connected. This feature
lets you use more than one USB-compatible device at a time.



Connecting to another computer

Connecting by cable: serial, parallel, and USB

Serial cable: Note that the blue
LapLink serial cable has two con-
nectors (one large, one small) at
one end, but you only need to
connect one of these two connec-
tors to a computer. Which one
you use depends on the ports that
are available.

Use the larger connector if one of
the computers has a 25-pin serial
port. Otherwise, use the smaller
connector. Make sure that one
end of the serial cable is attached
to a serial port on each computer.

Parallel cable:
Attach one end of the
yellow LapLink paral-
lel cable to a parallel
port on each com-
puter.

Parallel cable connec-
tions are not available
in Windows NT or Win-
dows 2000.

USB cable: Attach
one end of the purple
LapLink USB to a USB
port or USB hub on
each computer.

USB cable connections
are not available in
Windows NT or Win-
dows 2000.

Connecting to another computer by cable

When you start LapLink on two computers that are connected by a cable,
LapLink connects the computers automatically. If necessary, you can also
open a cable connection to another computer manually.

To manually connect to another computer by cable:
1 Click the Connect button on the LinkBar, and then click Cable.

2 In the Connection list, click the name of the computer you want to
connect to.

3 Under Services, check the services you want to use, and click OK.

[l If AutoConnect is
enabled but the con-
nection does not
open automatically,
click Port Setup on
the Options menu,
and verify that the
appropriate port
(COM, LPT, or USB) s
enabled for cable.
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Controlling a remote computer

Remote Control lets you use your computer to perform tasks on another computer. When you
connect to the remote computer, you become a Remote Control guest and the remote computer
becomes the host. When you‘re connected to a Remote Control host, you can lock the host’s key-
board and mouse and blank the host screen; you can also reboot the host. To add more security
to your remote control session, you can start LapLink before you log on to Windows.

Ll To permit locking
and blanking on the
host, change the
Locking options in
the Security dialog
box on the host com-
puter.
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You can remotely control another computer (be a guest), or let another
computer running LapLink control your computer (be a host).

Acting as a guest When you're a guest, the host appears on your screen
in a Remote Control window within LapLink. You can use your mouse
and keyboard to work on the host computer.

Acting as a host When your computer is a Remote Control host, other
people with access rights to your computer can connect to and work on
your computer. To act as a host, your computer needs to be running
LapLink and to be set up to allow others to connect.

You can open a Remote Control window while connecting or after a con-
nection is opened.

U To open a Remote Control window while connecting, click the Con-
nect button on the LinkBar, and then click Modem, Network, or some
other mode of connecting. Under Services, check Remote Control.

U To open a Remote Control window after connecting, click the Remote
Control button on the LinkBar, or click Open Remote Control on the
Window menu.

Locking and blanking the host computer

When you control a computer, you can lock the computer’s keyboard
and mouse and blank the computer screen. This prevents people from
working on the host system or from viewing your work. You must set up
the host computer to allow locking and blanking.

With the permission of the host computer, you can:

Lock the host keyboard Prevents anyone from typing on the host com-
puter’s keyboard while you're connected.

Lock the host mouse Prevents anyone from using the mouse on the host
computer while you're connected.

Blank the host screen Blanks the host’s screen, preventing someone at
the host computer from watching what you do while connected.



Controlling a remote computer

Controlling a remote computer

Vi Qptons Window

3.5 3

Remote Control guest Remote Control host

When you use Remote Control, the entire desktop of the remote computer is shown in
LapLink. You can then work on that computer as if you were right in front of it. (To alter-
nate between a window view and a full-screen view of the host, press CTRL+SHIFT+F.)

To lock and blank the host computer after connecting, click Blank
Screen, Lock Host Mouse, or Lock Host Keyboard on the Session menu. If
these options are not available, the host computer might not be set up to
allow locking and blanking.

Rebooting the host computer

You can reboot a computer you're controlling if the host computer is set
up to let you do this. For example, you might want to restart a host com-
puter to put into effect changes you have made on that computer or to
recover from problems with a program on that computer.

To reboot the host computer from the guest:

® On the Session menu, click Reboot Host.

Additional security: starting LapLink before the Windows logon

You can require someone who wants to access your computer as a guest
to type your Windows user name and password. To do this, set up
LapLink to start before you log on to Windows.

To start LapLink before logging on to Windows:
1 Click Program Options on the Options menu.
2 Click the Advanced tab.

3 Check the Always Start LapLink Before Windows Logon Prompt box,
and then click OK.

U To permit reboot-
ing, change the
rebooting option in
the Remote Control
Options dialog box
on the host com-
puter.

0 When using
LapLink on Windows
NT, Remote Control
guests must log on
by clicking Send
CTRL+ALT+DELETE to
Host on the guest
computer’s Session
menu, or pressing
CTRL+SHIFT+D.
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Transferring files and printing over a LapLink connection

Once you have connected to another computer, you can transfer files between computers and
use Xchange Agent to synchronize folders and files on both computers. You can also print a file on
a remote computer to your local printer or print a file on your computer to a remote printer.

Ll To distinguish
between the two File
Transfer windows,
look for the computer
name in the title bar
at the top of each
window.

U Another way to
select a group of files
or folders is to click
the right corner of
the group and drag
to the opposite cor-
ner, forming a selec-
tion box.

U To set prefer-
ences for copying
and moving, use the
File Transfer Options
dialog box; for more
information, see the
online Help.
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Transferring files

When you connect to another computer and open File Transfer, you can
transfer files and folders between that computer and your computer.

To start File Transfer and select the items you want to transfer:

1 Click the File Transfer button on the LinkBar, or click Open File Trans-
fer on the Window menu.

Two File Transfer windows appeat, one for the remote computer, one
for your computer. In these windows, you can view the files on both
computers.

2 On the left side of the File Transfer window for the computer you want
to copy or move a file from, click the drive and folder(s) in which the
file is located.

3 On the right side of that window, click the folder or file you want to
transfer.

U To select more than one item, hold down CTRL as you click each
item.

U To select two or more items listed next to each other, click the first
item and press SHIFT while you click the last item.

To drag and drop the selected files:
1 Drag the files to the target.

U To copy the files, hold down CTRL and your left mouse button as
you drag them to the target folder.

U To move the files, hold down SHIFT and your left mouse button as
you drag them to the target folder.

2 In the File Copy or File Move dialog box, do any of the following:
U Under To, verify the target, and change it if necessary.

U Under Options, check or clear the options as needed. For more
information, see the online Help.

3 Click OK.
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Transferring files using drag and drop
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LapLink’s Xchange Agent, Clone Folder, and SmartXchange features
automate the process of keeping the files on two computers in sync. You
can use these features to ensure that the most recent versions of the files
and folders you specify are saved to both computers.

Printing over a LapLink connection

Use Print Redirection to send a document from the computer at one end
of the connection to a printer at the other end.

U Print from remote to local While using Remote Control to view and
operate another computer, you can send a document from that com-
puter to a printer at your location.

U Print from local to remote When connected to another LapLink com-
puter, you can print a document from your computer to a printer at
the remote location.

To print a document over a LapLink connection, choose the Print com-
mand in the program in which you have prepared the document, and
then choose a printer at the opposite end of the connection.

Before using Print Redirection, you must add a printer driver for Print
Redirection to the computer you want to print from. (Add the driver to
the computer that doesn’t have the destination printer attached to it.)

You can add a printer driver during LapLink installation or use the Print
Redirection Setup wizard after installation.

U To set up a printer after LapLink installation, click Print Redirection
Options on the Options menu, and then click the Setup button to
start the Print Redirection Setup wizard.

[J For more informa-
tion about Xchange
Agent, Clone Folder,
and SmartXchange,
see the online user’s
guide and Help.

UJ You may need
your Windows CD-
ROM or printer disks
to install the printer
driver.
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Talking over a LapLink connection: Text Chat and Voice Chat

Using Text Chat or Voice Chat, you can communicate with someone at the other end of your
LapLink connection. Text Chat lets you exchange typed messages with the other person, while
Voice Chat lets you speak to the person.

22

Using Text Chat

You can use Text Chat to exchange typed messages with a person at the
other end of your LapLink connection.

A Text Chat window consists of two parts:

U The upper part displays the messages you have sent to the remote user
as well as those the remote user has sent to you. FEach message is iden-
tified by the name of the computer from which it was sent.

U The lower part serves as a note pad on which you write your messages.
It clears each time you send a message.

To send a message to the remote user:

1 Click the Text Chat button on the LinkBar, or click Open Text Chat on
the Window menu.

2 Click the Text Chat window.
3 Type your message.

Avoid pressing ENTER while you are typing your message. To start a
new paragraph, press CTRL+ENTER.

4 Press ENTER.

Using Voice Chat

Use Voice Chat to talk to someone you're connected to over LapLink
while using other LapLink services like File Transfer. To use Voice Chat,
you and the person at the end of the LapLink connection must both
have computers that are capable of recording and playing sound.

To talk to someone over Voice Chat:

® Click the Open Voice Chat button on the LinkBar, or click Open Voice
Chat on the Window menu.

LapLink “calls” the person at the other end of the connection and asks
if he or she wants to talk to you. If the person accepts the Voice Chat
connection, a Voice Chat window opens, and you can begin talking to
the other person. Speak into the microphone and listen through
headphones or speakers.
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Using Text Chat
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Type your messages in the lower part.
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Using Voice Chat
e —= The Voice Chat window appears while
t
e e you're connected.
Chatting with: Reepicheep Using:  half duplex \ .
g | . How you communicate over the connec-
Speaker level - X
[_gptors.._| tion depends on whether the current con-
- versation is using half duplex or full duplex.
ute:
During a conversation, you can adjust your
speaker and microphone and mute them, if
necessary.
™ Mute
‘f'ou can talk when the stoplight icon on the right is % 1 When you’re using half duplex, watch the
green. When the stoplight icon is red, don't talk; the other o .
person s taking. Tl icon to determine when to talk.

Depending on the configuration of the sound card in both computers,
your voice and the voice of the other user may be transmitted simulta-
neously, as if you were using a telephone (full duplex), or alternately, as
if you were using a walkie-talkie (half duplex).

Voice Chat conversations are always half duplex unless both sound cards O The lower band-
are configured for full duplex. The indicator at the top of the Voice Chat  width of slow con-
window shows whether your current conversation is half or full duplex. nections may prevent
(If you're having a half duplex conversation, remember to wait to speak e use of full duplex.
until the stoplight icon in the lower right corner of the window displays

a green light.)
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LapLink.com License Agreement

IF YOU BREAK THE SEAL OR OTHERWISE OPEN THE PACKAGE CONTAINING THE SOFTWARE PROGRAM
MEDIA, YOU ARE BY THAT ACT AGREEING TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS LICENSE
AGREEMENT.

Ownership of Software. You acknowledge and agree that all of the computer programs and associated documen-
tation contained in this package (collectively, the “Software”) are owned exclusively by LapLink.com and/or its
licensors. The Software is protected under copyright and other intellectual property laws of the United States and
international copyright treaties. You acknowledge and agree that the price paid by you for the Software is a license
fee granting you only the rights set forth in this License Agreement.

License. LapLink.com grants to you, and you accept, a limited, non-exclusive and revocable license to use the Soft-
ware, in machine-readable, object code form only. You agree to use the Software only as authorized in this License
Agreement. This License Agreement does not convey to you any ownership rights or any other interest in the Soft-
ware.

Scope of License. This is a single-user, multiple computer license, which means you are authorized to use the Soft-
ware on up to a total of three personal computers that are used exclusively by you (e.g., office, laptop and home).
A valid license must be purchased for each person who will use the Software. You may only use the Software to link
with a computer not used solely by you if the user of that computer has a valid license.

If this software is to be installed on a network server, or more than one user can run the Software, you must pur-
chase an additional license for each user or work station. Please contact the location where your purchased the
Software and this license, or contact LapLink.com, to obtain additional licenses.

You may not copy or make any changes or modifications to the Software, and you may not translate, decompile,
disassemble, or otherwise reverse engineer the computer program(s). You may not loan, rent, lease or sublicense
the Software or any copy to others for any purpose. You agree to use all reasonable efforts to protect the Software
from unauthorized use, modification, reproduction, distribution or publication. You are not permitted to make
any uses or copies of the Software that are not specifically authorized by the terms of this License Agreement, and
LapLink.com reserves all rights that are not expressly granted to you. Your adherence to this License Agreement
will allow LapLink.com to continue developing innovative and useful products and providing a high level of cus-
tomer service and support.

Term. This license will become effective on the date you acquire the Software and will remain in force until ter-
minated. You may terminate this license at any time by removing the Software from your computer and destroying
the original Software and all copies. This license will automatically terminate if you breach any of the terms or
conditions set out in this License Agreement. You agree to remove the Software from your computer, and either to
destroy the original Software and all copies of the Software and documentation or to return them to LapLink.com,
upon termination of this license for any reason.

Transfer. You may transfer your license of the Software to another party by transferring the original program
media and all applicable documentation, including the original of this License Agreement, to the recipient, who
agrees to the terms of this Agreement. All other copies of the Software must be deleted and/or destroyed. Any trans-
fer of possession of the Software terminates your license and all associated benefits under this License Agreement.
You must notify LapLink.com in writing of such a transfer.

Archival Copy. You may make one copy of this Software and associated documentation solely for backup or archi-
val purposes. Alternatively, you may transfer this Software to a single hard disk drive, provided that you keep the
original program media and accompanying documentation in your possession for backup or archival purposes.
Any such copies of the Software or documentation shall include LapLink.com’s copyright and other ownership
notices. No other copies of Software or documentation may be made by you or any person under your authority
or control.

Limited Warranty. LapLink.com warrants the physical program media and physical documentation to be free
from defects in materials and workmanship for a period of 90 days from the date of your purchase. If you notify
LapLink.com of defects in materials or workmanship during the warranty period, LapLink.com will replace the
defective program media or documentation or, at its option, refund the purchase price. Your remedy for breach of
this warranty shall be limited to replacement or refund and shall not encompass any other damages. No dealer,
distributor, agent or employee of LapLink.com is authorized to make any modification or addition to the warranty
and remedies stated above.
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LAPLINK.COM SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
LAPLINK.COM DOES NOT WARRANT THE PHYSICAL PROGRAM MEDIA, PHYSICAL DOCUMENTATION OR
COMPUTER PROGRAM(S) OTHER THAN AS EXPRESSLY STATED ABOVE, NOR DOES LAPLINK.COM PROVIDE
ANY WARRANTY AS TO THE OPERATION OF THE SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR APPLICA-
TION, USE, OR PURPOSE.

Limitations of Liability and Remedies. IN NO EVENT SHALL LAPLINK.COM OR ITS LICENSORS BE LIABLE
FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGE, INCLUDING BUT NOT LIMITED TO SPE-
CIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR OTHER DAMAGES, EVEN IF LAPLINK.COM OR ITS LICEN-
SORS ARE ADVISED, IN ADVANCE, OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL THE
LIABILITY OF LAPLINK.COM OR ITS LICENSORS EXCEED THE PURCHASE PRICE PAID FOR THE SOFTWARE, LESS
ALL APPLICABLE TAXES AND DUTIES. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIA-
BILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE AFOREMENTIONED LIMITATION OR
EXCLUSION MAY NOT APPLY TO YOU.

U.S. Government Restricted Rights. The Software is provided with Restricted Rights. Use, duplication, or dis-
closure by the United States Government is subject to restrictions set forth in subparagraph (c)(1)(ii) of The Rights
in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the
Commercial Computer Software—Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/Manufacturer
is LapLink.com, Inc., 18702 North Creek Parkway, Bothell, Washington 98011 U.S.A.

Updates. To receive notification of future Software updates, please complete and return the registration card. Also,
please locate the serial number of your copy of the Software on the program media. You will need this number to
receive updates and technical support from LapLink.com.

Trademarks. LAPLINK.COM, LAPLINK, DESKLINK and the associated logo(s) are registered trademarks of
LapLink.com, Inc. No right or license to any trademarks owned by LapLink.com or others appearing in the Soft-
ware or packaging is granted to you by this License Agreement.

Miscellaneous. Unless otherwise restricted by law, you agree that this License Agreement shall be construed,
interpreted and governed by the laws of the State of Washington of the United States of America, without regard
to the laws governing conflicts of law. If any action is brought by either party against the other regarding any sub-
ject matter of this License Agreement, the prevailing party shall be entitled to recover, in addition to any other
relief granted, reasonable attorney fees and expenses of litigation. You further agree that any claim relating to this
License Agreement shall be brought in the courts of competent jurisdiction in the State of Washington. If any term
of this License Agreement is declared void or unenforceable by any court of competent jurisdiction, enforcement
of the remaining terms shall not be affected. No waiver of any right under this License Agreement shall be effective
unless in writing and signed by both parties. No waiver of any past or present right arising from any breach or
failure to perform shall be deemed to be a waiver of any future right arising under this License Agreement. This
License Agreement sets forth the entire agreement between LapLink.com and you with respect to all matters cov-
ered herein.

IF YOU HAVE ANY QUESTIONS CONCERNING THIS LICENSE AGREEMENT, PLEASE CONTACT LAPLINK.COM
AT 18702 NORTH CREEK PARKWAY, BOTHELL, WASHINGTON 98011 U.S.A. (425.483.8088), OR CONTACT
YOUR REGIONAL LAPLINK.COM OFFICE.
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